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BASIC  OVERVIEW
This is a basic level course designed to introduce those with little or no experience to the
world of computing. Please read the overview carefully, as it will help you apply what you
have leaned on your course.

Basic Tutorial Part 1 (page 2)
� Basic Concepts

Types of Computer, Software, Computer Memory, Graphic Interface, 
Electronic Mail, Health & Safety, Computer Viruses, Software and the Law.

� Starting the Computer
� Shut Down the Computer
� The Mouse
� Settings
� The Desk Top
� The Icons    
� Windows
� Minimise / Restore / Close

Basic Tutorial Part 2 (page 8)
� The Start Button
� Opening Word
� Cursor / Insertion Point / Insertion Bar
� Page Set-up
� Saving a Document in Word
� Selecting Text /Objects
� Formatting Toolbar
� Standard Toolbar

Basic Tutorial Part 3 (page 17)

� The Drawing Bar
The Text Box Tool, Rectangle and Oval Tools, Line and Arrow Tool,
Autoshapes, Word Art,

� Formatting and Attributes of Shapes & Lines

Basic Tutorial Part 4 (page 20)

� Microsoft Excel
� Manipulating and selecting Cells
� Entering cell information
� Navigating in Excel
� Moving cell information around
� Toolbars
� Autosum, Paste function, Sorting Information, The Currency Tool, Percentage and 

Decimal points

Basic Tutorial Part 5
� Evaluation Exercise
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BASIC TUTORIAL PART 1

1. The basic concepts of hardware, Information Technology software and Information
Technology (IT).

� Hardware is any part of a computer that you can see or touch.
� Software describes the electronic instructions that tell the computer what to do.

2. Types of computers. ( Their capacity , speed , costs, and uses)

� Personal Computer (PC) - A non mobile computer normally used in Office or Home
environment. The speed and memory capability is generally related to the cost. 
� Laptops- A mobile computer with the capabilities of a PC but usually more costly
due to the precision of the construction of the computer.
� Mini Computer(Hand Held)- A sophisticated electronic filo-fax usually fairly inexpen-
sive and often able to connect up to a PC.

3. Main parts of a personal computer.

� CPU (Central Processing Unit) this is the main chip in a computer, it is it's brain. It
communicates with input ,output and storage devices to perform tasks. The speed of
this device is measured in MHz
� Hard disk- this is the primary device that a computer uses to store information.
� RAM (Random Access Memory) RAM temporarily stores information inside a com-
puter. Loss of power will result in loss of information.
� Removable storage devices-diskette, zip disk, CD-Rom, Optical Memory Drive.
These devices with the exception of the CD-ROM (Read Only Memory) can read and
write memory to the hard disk of the Computer. It is now possible to write to CD.
� Input devices are the Keyboard, the Mouse, Scanners, Digital Cameras, Trackballs,
Light pens, Joystick and Graphic Tablets.
� The main output device is of course the Screen along with others such as the
Printer, Plotters, Speakers and Speech Synthesisers.

NOTE:- The term used for any Hardware connected to a PC is a "Peripheral Device"

4. Software

� System software.  This is the primary software that controls the overall activity of
the computer e.g. Windows 98 /Windows 2000.  
� Application software. This is software that allows you carry out specific tasks on the
computer e.g. you would use Word Processing (Word 97) software to write letters, and
Image Manipulation (Adobe Photoshop) software for altering photographs and creating
designs.

5. Types of computer memory.
� Hard Drive most commonly indicated in the PC as (C:)Drive . The operating
System software, the Application software and any documents that you have created
and have chosen specifically to save to the hard drive all live in here.

Basic Level Tutorial / Making Connections Project 2003  

Copyright 2003 by Jonathan Brown / Angus Council    Page3



� ROM for example CD Rom. This memory can only be read from, it cannot be
altered. For example in the case of a file being copied from a CD you could manipu-
late the file on your PC and  then store it on your own internal hard drive but you
could not return it to the CD in it's altered state.
� RAM This area determines the number of programmes that can be run at one time
and how fast the programmes will operate. RAM works similar to  walking into a work-
shop ( the hard drive), making a copy of one of the workshop tools (a software appli-
cation) then returning to the RAM with it to carry out your task. It is vulnerable in that
should the power supply cease all would be lost. For this reason the task you are car-
rying out must be saved to the Hard disk.

NOTE: Memory is stored in bits, bytes, Kilobytes, Megabytes and Gigabytes. RAM  size is
of particular importance with regard to the computing power and speed of a PC. RAM and
Hard Drive capacity can normally be upgraded on PCs.

6. Graphical User Interface (GUI)
� Windows is a Graphical User Interface. A GUI allows you to use pictures (icons)
instead of text commands to perform tasks on the computer. A much easier system
than the MS-DOS ( Microsoft -Digital Operating System) which was used by IBM com-
puters until relatively recently.

7. Electronic Mail (e-mail)
� Electronic mail commonly referred to as e-mail is a way of transmitting written text,
files, images and sound from one computer to another over a global network called
the internet.

8. Uses of the Computer in the home.
� The PC has a host of uses within the family.
� Keeping track of household accounts and related information.
� Hobbies. 
� Homework. Ideal for research on projects.
� Communicating by e-mail and research on the net.
� Working from home.

9. Health and Safety.
� Posture and seating are of great importance fig1 shows the correct position and
take frequent breaks away from the computer.
� Make sure the lighting is correct.
� Provide good ventilation .
� Keep coffee and other liquids well away from the computer
� Make sure that all your power cables are secured and that power points are not
overloaded
� Be aware of RSI (Repetitive Strain Injuries) and eye strain.
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10. Computer Viruses

� Computer Viruses attack the software within your machine.
� They are caught most commonly from files down loaded from the internet.
� You should therefore be very cautious about attached e-mail files and what sites
you choose to download files from.
� Virus protection in the form of software is available and it is advised that you install
a copy of such a programme on your system.

11. Software and the law.

� When you purchase a copy of a software application you enter an agreement with
the company that only the software will be used on only one machine, and that you
will not make copies of it for resale.
� You can obviously also buy copies of software for educational use. This grants you
a license to install the software on several machines but forbids you from using it for
commercial purposes.
� Freeware is an application which as it indicates is free for you to use for your own
purposes.
� Shareware is an application that the author distributes to you on trust in the expec-
tation that if you wish to continue using the software after a short , usually 30day peri-
od, you will pay him an amount indicated by him for the use of the software. He will in
turn register you and furnish you with any modifications or updates he make to the
application.

12. Starting up the Computer

� To start up your computer you will find a button, normally placed on the front of the
casing of the PC. In the case of a laptop this is most commonly found on the side of
the case and is covered by a sliding protective cover which stops the laptop from
being switched on inadvertently. Some computers require you to hold this button in for
some seconds until such time as an led light flashes on the casing. This process is
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IDEAL POSTURE WHEN WORKING WITH A SCREEN
The Head

� The head is held over the shoulders and is in line with the but-
tocks

The Chair / Seat
� The seat should tilt forward and have a `rocking` action. Adjust
seat height so that the hip joint is higher than the knee joint.

The advance Two step
� Place one foot in front of the other, try altering feet position dur-
ing the day. Movement is essential, exercise throughout the day by
rocking three to four times at half hourly intervals.

Desk Height
� The middle row of the keyboard is level with the elbow.

Eye Height
� The top of the VDU screen should be level with the eyes, and
not lower than 21 degrees at the base.

Fig1



known as "Booting Up".

� In some cases the screen will automatically switch on with the machine as is the
case with most laptops. Other machines you will have to switch the screen on sepa-
rately. Peripherals should all be switched on beforehand. It is advisable to wait 15 sec-
onds in between each power up of a peripheral to avoid power surges that might
knock out another piece of equipment.

13. Shut down the computer properly.
� To shut down the computer. Proceed to the
start button most commonly found in the bottom
left-hand corner of the screen, click once with
the primary mouse key ( the left-hand Key) this
will open a window similar to the one shown in
Figure 2. If the first option is checked (a black
dot in the white circle known as a radio button)
and you then click Yes the computer will proceed to the close down mode.
� If the second option is checked and you click Yes the computer will close down and
then Restart.
� If the third option is checked and you click Yes then the computer will close down
and restart in MS-DOS mode. MS-DOS stands for Microsoft Disk Operating System.
MS DOS is an operating system that performs tasks using textual commands.

14. The Mouse
The standard basic mouse has two buttons at the front of it. As mentioned earlier the
left-hand mouse button is referred to as the primary mouse button and the right hand
button as the secondary mouse button.

15. Settings
Settings for certain aspects of the computer can be accessed from an area called the
"Control Panel" You will be shown this area and what aspects are important for you
to be able to alter at this stage of your computing.

16. The Desktop
The Desktop, often referred to as the Active Desktop, is the screen that greets you
after the computer along with the monitor have been booted up i.e. a background 
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Fig 2

The buttons serve 4 basic functions.
1. One click with the left button will select an object. To click just press and
release.
2. A double click opens a document or an application. To double click, press
and release the left mouse button very quickly in succession..
3. Dragging and Dropping:- Dragging and dropping makes it possible to move
objects on the desk top. To drag and drop, position the cursor over the object
you wish to move ,hold down the left mouse key and move the mouse, you will
find that the object you took hold of will be dragged along with the mouse cur-
sor.
4. A single click with the right button displays a list of commands on the screen.
To right click press and release the right button.



screen pattern along with a number of small graphics normally displayed on the left
side of the screen. These graphics are referred to as "Icons". Along the bottom of the
screen there is a bar (The Task Bar) with a raised rectangle at the left-hand end with
"Start " written on it, at the right hand end you will find the time displayed. And perhaps
some other small icons.

Think of the "Active Desktop" as the first door you come to in order to access the
information in the computer.

17. The Icons
There may be many icons displayed on the screen and you will rarely boot up a com-
puter to find the same lay out of Icons displayed, as the entire desktop is fully cus-
tomisable.

Using the concept of the Icons representing doors into different areas of the computer,
the most important Icons you should know about are, the following:- My Computer,
Recycle Bin and the Start Button on the Task Bar. You will be shown around these
during the course.

18. Windows
Double clicking on an icon will open a rectangular box called a "Window". An
example of which is shown below. This win-
dow was opened by double clicking on the
"My Computer" icon. It shows five further
icons which in turn will allow you to access
further areas of the computer. Each time you
click on an icon you will of course be pre-
sented with a window similar to that shown in
Fig 3.

Window properties
Resize a window:- Guide the cursor to the border of any window very slowly and you will note that the cursor
changes to a thin double headed arrow, holding the left mouse button down and dragging the mouse will
resize the window. Dragging from the right or left will alter the width alone, dragging from the top or bottom will
alter the height. Placing the cursor in any corner will show a thin double headed 45 degree arrow, this will
resize both height and width at the same time.

The actual window itself can be customised and will therefore not necessarily appear the same on every com-
puter.
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Fig 3

Fig 4

Menu

Toolbar

Scrollbar

Status bar

Icons



The actual icons displayed in the window can be displayed in many different ways. To alter the appearance 
of the window contents proceed to the "View" menu, there you can not only alter how you view the icons but
can choose whether you wish to display a "Toolbar" or "Status bar".

The main Icons displayed in this particular window are:- " 3½ Floppy (A)"this gives access
to the floppy drive; "(C:)" gives access to the hard drive(usually referred to as C Drive);
"(D:)" gives access to the CD Rom drive;  "Control Panel" will let you in to the settings,
mentioned earlier;"Printers" gives access to any printers you might have configured for your
computer.

19. Minimize / Restore / Close
The three small buttons in the top right corner of the window are used as
follows:- 

1. Clicking once on the minimize button will result in the window disappearing from
the active desktop and appearing as an embossed rectangle in place of the sunken
rectangle on the Task bar at the bottom of the page.
2. Clicking the Restore button will, providing the window is displayed as in Fig 4 on
page 6, open the window to fill the entire desktop. The restore button will now have
change to display 2 small boxes, clicking again will return the window to it's original
state.
3. Clicking on the X will close the window.

Note: Every window displays these icons and they perform in exactly the same way.
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BASIC TUTORIAL PART 2

1.The Start Button
� The "Start" button located at the left hand end of the task bar at the foot of the
page is the short cut to the applications and other utility programmes available in the
computer.

2.Opening Up Word
� Microsoft Word is a word processing programme used throughout the world.
� A word-processing programme allows you to manipulate text.
� Proceed to the start button and click once, run up to "Program Files" this will open
up a large sub menu.
� Amongst the Microsoft applications you will find a turquoise W with the words
“Microsoft Word” written alongside. Click on this.
� The application will open up in the desktop.
� The application always opens with a fresh document in place  and should appear
similar to that shown below in Figure 1

2.  Word/The Window
� The dark blue strip at the top of the page is the "Title Bar" for the document. It
describes the application and also the name of the saved document. Prior to saving,
the document is given a default name.  For example, “Document 1.doc” if it is the first
document opened and “Document 2.doc” if it is the second document opened.
� Immediately below the Title bar is the "Menu bar". A lot of the information con-
tained in these menus is also available as icons, which provide shortcuts to some of
the tools. 

� The next two bars of tools are, respectively, the "Formatting Bar" and the
"Standard Tool bar".

� The Large white area is of course the Page/Document with rulers showing both at
the top of the page and to the left also with scroll bars to the right and at the bottom of
the page.

� Below the page and scrollbars is a further toolbar, this is the "Drawing Tools Bar"
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� The Information Bar is last. This displays information such as which page and sec-
tion you are on and the line number etc.

� Remember that all these toolbars are customisable and their presence will depend
on whether they have been selected to be shown or not by the user. To call up other
toolbars or to change the ones you have at present you must go to the View Menu
and select what you want.

3. Cursor/Insertion Point/Insertion Bar
� The cursor will default to the upper left-hand corner of the document when it is
opened. It takes the form of a short black line referred to as the "Insertion point" which
flashes on and off. At this stage the Insertion Point can only be moved downward
using the "Enter" key, and upward using "Backspace".

� The cursor will remain in the shape of the white arrow as long as you are in the
"Toolbars" area or the margin, however when you move down to the main part of the
document within the margins it will change it's shape to a large "I" commonly known
as the insertion bar. This bar can be used to place the insertion point in a specific part
of a piece of text in order to carry out some task.

4. Page Setup
The first task in any word processing is to set up the margins of your document. 

� Proceed to the  "File" menu and down to "Page Set Up".
� A dialogue box in Figure 2 will appear.
� From this box you can set up the page margins
for the document. To make a change to a margin
you must click on one of the arrowheads to the
right of the number displayed in the field. The
arrow pointing up will increase the margin, the one
pointing downward will decrease it. The changes
you make to the margins will automatically update
the document preview immediately to the right.
� Gutter is a term referring to an extra margin
placed on a document in the event of the need to
bind pages together. The gutter is the dead area where the pages would be bound.
� Now proceed to the Tab next to Margin on the box and left click once. This will
allow you to set the paper size and also to check if you wish the page to be a Portrait
or Landscape set up. Most documents you use will be Portrait. Click OK and you will
return to your document. 

5.  Saving a Word Document
It is always wise to save a document very early on it's creation. It is also important to
remember to save the document from time to time as you proceed with it's creation. The
procedure is as follows:
This will save your document to the area on the Hard drive called "My Documents" which
has been specifically put aside for you to store your files. However it is always important to
take a further copy of your file to some other type of external storage, a floppy disk or a Zip
Drive for example; this is done lest your hard drive should crash.
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1. For this example first type your name in the top left-hand corner of the Word docu-
ment.
2. Now proceed to the File menu and click once, this will give you a drop down menu
from which you must choose  SAVE, click this and you will get a "Save As Dialogue"
box as displayed in Figure 3.

3. The destination of the file has defaulted to MY Documents in the example above.
Had it not, then clicking on the arrow head to the right of the field will present you with
other destination options in a drop down menu.
4. Note that in the field titled "File Name" beneath the main window you will see your
name followed by .doc (.doc is a file extension) You should select your name and then
type the name you wish to call your file, leave the file extension .doc.
5. The last field refers to the file format. This will be covered at a later stage.
6. At the right hand side of the page you will see four bar buttons.  Don't concern
yourself with the lower two at this stage. Make a final check that the destination you
have chosen is correct and that the name of the file is as you wish and then click the
Save button.
7. You may now hear your hard disk whirring in the background and the cursor will
momentarily change to an hour glass shape indicating that the computer is busy carry-
ing out a task, in this case saving a document. The Save As dialogue box will also dis-
appear.

6.  Selecting Text/Objects
When you wish to carry out a specific task on text, an object or handling a file or folder
the object in question must be selected. At this stage we will deal with selecting text
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Folders

Files

This window will be displayed every time you save a file for the first time. From the
top, there is the Title bar, below that the destination area of the file which will normally
default to "My Documents" unless you previously saved a file to another area of stor-
age either internally or externally during that session. To the right of this are three
small icons representing folders. The first will take you one up in the file hierarchy, the
second will bring up your most used folders. The third will create a new folder for you.
The next three icons deal with the layout of the files in the window below and other
information. The last one deals with uploading files to a remote computer, ignore the
last four icons discussed as you will certainly not require them at this stage. The main
part of the window displays all the files and folders contained in that location. The two
fields below are described in the main text descriptor.



only. (Refer to section 14 of  Basic Tutorial Week1 for mouse clicking information)

1. The text you have in your document, in this case your name, will be used for learn-
ing how to select.
2. Place the "I" bar immediately to the right of the text. 
3. Click and hold down the left mouse button.
4. Now drag back to the left through the text.
5. Your text should now look like the example shown in Figure 4.
6. This selection process is also possible by placing the cursor to
the left of the text you wish to select and dragging to the right.
7. A further method is by placing the "I" bar in the margin to the
left of the text and clicking once with the left button. An entire paragraph can be
selected by this method. However it is necessary to hold the left mouse button down
and drag down the page in the margin. This method will only select entire lines, para-
graphs or the complete document.
8. To select an individual word in a sentence place the "I" bar in the middle of the
word and double click.
9. You can also go to the "Edit" menu and come down to "Select All". This will select
everything within the entire document.
10. REMEMBER THAT NO ACTION CAN OCCURS WITHOUT A SELECTION
BEING MADE.

7. Formatting Text / Formatting Toolbar

The bar displayed here in Figure 5 is the "Formatting" bar.  It will allow you to change the look as well
as the alignment and colour of the text you have typed on your document.

Follow the directions below to action on a selection you have made:-
a) Select a word or sentence, click the arrowhead and run down the list of fonts click-
ing on the one of your choice. There are scroll bars provided to search the contents of
the menu.
b) Select a word or sentence, click the arrowhead and run down the list of numbers
(font sizes are measured in points). Click on the one you wish. There are scroll bars
provided to search the contents of the menu.
c) Select a word or sentence.

1. B is for Bold type
2. I is for Italic type
3. U is for Underlined

Clicking on the appropriate letter will format the type style for your text.
d) The first three are for Aligning (respectively:- Left align, Centre, Right align and
Justify) your text. Whenever you open a new document in Word it will default to Left
Align. To realign a sentence you need only place the "I" bar at the end of a word.  To
realign an entire paragraph you are required to select all the text in that paragraph, by
double clicking the left mouse button, within that paragraph.   To Justify text select the
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Fig 4

(a) (b) (c) (f) (g) (h) (i)(d) (e)

Arrowheads like this denote that there is a drop down or pop up menu. Left clicking will reveal the
menu.

Fig 5



appropriate paragraph and click the justify icon. This will space out the text and create
the impression of wall to wall text. Note: This paragraph has been justified.
e) These two icons are for creating lists. The first being an Ordered list the second a
Bullet list. Type a heading for your list, then press enter, with the cursor now on the
line below your list heading go to the Toolbar and select the Ordered list icon. As soon
as you click on this icon and then return to your document you will note that the num-
ber 1. has been inserted, you can now type the content of your list. After completing
the content, press enter again, you will now find a number 2. has been inserted again
you must enter your content and then follow on as before. When you want to complete
the list, you must press enter twice to come out of List mode. The Bullet list works in

exactly the same way. Note: Both Ordered and Bullet lists can be altered by using
"Bullets & Numbering" from the Format menu.
f) These icons allow you to either increase or decrease the indent of text. You need
only place the "I" bar on the relevant line you wish to change or in the case of a para-
graph you will need to select the entire paragraph.
h) The Highlight tool works like a normal highlighting pen you simply select the tool
and return to your document where the "I" bar has had a pen added to it. You then
hold down the left mouse key and drag through the words you wish to select. If you
want to undo this you simply drag through the words once again.
i) This Tool will change the Font colour. Select the text you wish to change the colour
of and proceed to the Font colour icon. The colour shown below the letter A is the
present colour in use. To change the colour click the small arrow head next to the A,
this will present you with a drop down colour palette.
Simply click on the desired colour.

8.  Standard Toolbar

Figure 6

(a) Clicking this icon will produce a new document in the Word Window. The same icon
can be found under the file menu. However, clicking on this will steer you to a new docu-
ment but offers you template alternatives should you wish to use one.
(b) This icon will open an existing document in the window. You will of course have to
navigate using a file dialogue box similar to that shown in Figure 3. The procedure is similar
to that described in Section 5. The differences being that firstly you must  navigate to the
specific folder or file and once found click  "Open".
(c) Clicking on this icon will save changes to any previously saved document. It will also
allow you to commence the saving procedure described in Section 5. 
(d) This is the "Print" icon; clicking here will initiate the printing process.
(e) This icon is "Print Preview"; it will allow you to view your page in it's entirety prior to

Basic Level Tutorial / Making Connections  Project 2003  

Copyright 2003 by Jonathan Brown / Angus Council    Page13

g) This is the Border Tool. It works by drawing borders around any selection you
might have made before selecting the Border tool. It has a small arrowhead to the
right of it indicating that there are several types of borders available.

Fig 6

(a) (b) (c) (f) (g) (h) (i) (j)     (k)(e)(d) (l) (m) (n) (o)



printing. To return to your document from "Print Preview" click on "Close " in the "Menu"
bar.

(f) This is the spell check icon. Clicking on this icon will check the spelling of your
entire document.
(g) This icon works in conjunction with the next three icons and is referred to as "Cut".
It is shown ghosted at the moment. To action this icon the word or paragraph you wish
to remove from a document must first be selected. Clicking on the "Cut" icon will then
remove the selection from the document and copy it to the "Clipboard" (This is a tem-
porary storage area in the computer reserved for cutting and copying any selection.
Note: It can only store one selection at a time.)
(h) This icon, also ghosted, is the "Copy" icon and will copy any selection from the
document to the clipboard.
(i) This is the "Paste" icon. Clicking here will paste anything that has been copied to
the clipboard. Note: These three functions are universal throughout different applica-
tions and will also allow you in a lot of cases to copy from one application to another.
(j) Undo-see below
(k) "Redo"; this icon, works in conjunction with “Undo”. They will, as suggested, undo
the last action you made on the computer. Redo will undo the last "Undo" you carried
out back to the last time you saved the document. The number of undoes you have
made of course governs "Redo".
(l) This icon will allow you to create columns in your document. Clicking on it gives a
small drop down menu, which gives you the option of having 1-4 columns on your
page.
(m) This icon allows you to choose whether you view the Drawing toolbar or not. This
one is shown in selected mode. *See Section 2 for viewing and hiding toolbars.
(n)This window allows you to view the document at different sizes, it is known as the
"Zoom". By clicking on the arrowhead to the right you are presented with a percentage
figure that decreases or increases the size of the document according to figure you
choice of number.
(o) The final icon is one that appears in most applications, it provides a source of help
pertinent to that particular application.
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BASIC TUTORIAL PART 3

1. The Drawing Bar 

i) This is the "Text Box" tool. It will allow you to place text within a rectangular box,
which can be moved to any part of the document. Clicking the icon with the cursor will
change the cursor to a plus sign on your return to the document.
You must now hold down the left mouse button and drag in a diagonal direction.
You should now have a rectangular shape on
the document similar to that in Fig 1. The
small white squares on the edges and the
corners are called "Control Points" and will
allow you to resize the box. Top and Bottom
control points, deals with height. Right and
Left, deals with width. Any corner control
point will alter the width and height simultane-
ously. The herring bone pattern around the
borders denotes that the box is selected and it should also have an insertion bar flash-
ing in the top left-hand corner. Text can then be entered into the box and formatted in
exactly the same way as it would were it typed into a document.
Clicking on the border of the box will change the selection pattern to a series of small
dots and at the point of the mouse two lines crossed at 90 degrees with arrow heads
at all four ends will appear, somewhat like a compass. Holding the mouse down at this
stage on the dotted pattern will allow you to drag and drop the box anywhere in the
document.

g) & h) These two tools are the Rectangle and Oval tools and are used for drawing
rectangles, squares, ovals and circles. They work in the same way as the Text box
tool. However, to create a perfect square and/or a perfect circle you must hold down
the "Shift" key before you commence dragging across the document; you must
remember to release the mouse key prior to releasing the "Shift" key. The manner of
selection for these shapes is similar to the Text box but with the exception of having
no border patterns.

e) & f) These are the Line and Arrow tools. To create a line on your document check
the tool you wish and return to the document, place the cursor where you want the
line to start, hold down the left mouse key and drag to where you wish the line to end.
The arrow tool will create an arrowhead at the end of the line you draw. After releasing
the mouse key you will note that the line you created has control points at either end.
The lines can be resized or their angles altered by dragging on the control points.

d) This area is known as AutoShapes and clicking on the AutoShapes button will
throw up a floating palette like that shown in Fig 2; the left hand side shows the
Categories and clicking on the respective arrow head will throw up a submenu as
demonstrated in Figure 2. Clicking on one of the shapes shown will allow you to draw
a shape in that style. Again, once the object is drawn it will remain selected (until you
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(a) (b) (c) (f) (g) (h) (i) (j)(e)(d) (l) (m) (n) (o)(k) (l) (n) (o)

Please note that the following explanations are not in alphabetical order.

Fig 1



deselect) on the document showing
control points. In addition to the stan-
dard control points there are in this case
three further diamond shaped points
coloured yellow similar to that shown in
Fig 3. Clicking and dragging these
points will change various attributes of
the selected objects. Not all objects
have these added points and they may
not have three of them.

j) Word Art allows you to type text into
an editor (a floating window) and then converts the text to an
editable object as shown in Fig 4.
The control points will allow you to resize the text and the diamond
shaped control point allows other attributes to be changed.

k) This is the Fill Colour tool
when any of the objects
described above are selected clicking on this icon will fill the object with the colour
shown in the colour bar below. To change the colour your must click on the small
arrow head to the right of the icon this will display a small colour palette, clicking on
one of the colour swatches here will set a new colour fill for the object.
l) This is the Line Tool It works in the same manner as the Fill Tool but applies the
colour changes to the borders of any of the objects. Clicking the arrowhead will let you
choose an alternative colour.
m)The Text Colour tool. This tool will change the text colour. Clicking the arrowhead
will let you choose an alternative colour.
n) Clicking the Line Style icon gives you the option of changing the style and weight
of any line or border. Select an object or a line you wish to change and choose the
style you wish from the list.
o) This icon, Dash Style lets you choose from a list of assorted broken lines. The tool
works in the same way as the Line Style tool.
p) The Arrow Style lets you choose from a list of lines with arrow shapes at either
end of them. A line must be selected and then a style applied by clicking on the appro-
priate style.
q) The Drop Shadow tool allows you to select from a list of pre-set drop shadow
effects and also gives you the opportunity to customise the settings yourself.
r) 3-D This tool will create 3 dimensional shapes from a basic 2-D object and render
the surface with a realistic colour surface. The settings in here can also be cus-
tomised.
a) Draw. Clicking on Draw will open the menu shown here in Fig 5. A number of
actions can be carried out from here. The top three sections only are dealt with here.     

Group/ Ungroup /Regroup. When a multiple selection of objects is made clicking
group will combine the objects into one scalable object with the normal six standard
control points. 
Order. When you have several overlapping objects on your document and you wish to
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Fig 2

Fig 3

Fig 4



alter their order i.e. The last object placed on the doc-
ument is foremost in order  and will cover any other
previously placed object. By selecting an object you
can reposition the object using with any one of the six
different commands.

Grid will set up an invisible grid that allows you to
snap (the object will seem to jump into place when
you are positioning it) your objects to unseen lines on
the page thus helping you to align the position of
objects.

Nudge will act in a similar way to the cursor keys on
your keyboard nudging your object either up, down,
left or right.

Align or Distribute will allow you to position objects
in a number of different ways. The menu is graphical-
ly illustrated. You must however remember to select
all the objects that you wish to reposition.

Rotate or Flip will do just as it says. As well as the Free Rotate icon in the submenu
you can also use icon (c) on the Drawing bar to rotate any object.

b) This arrow will, if you hold down the left mouse button and drag diagonally, encom-
pass  a group of objects and create a multiple selection from them.

REMEMBER, TO APPLY ANY OF THE ABOVE YOU MUST FIRST SELECT THE
OBJECT.
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BASIC TUTORIAL WEEK 4

Microsoft Excel
Proceed to Start, click with the left mouse button and go to Programs, in here you will
find an icon with a turquoise (see Fig1) with Microsoft Excel written to the right of it. Left
clicking this icon will open the application Microsoft Excel.

Excel is a spreadsheet programme, which allows you to handle and sort Information both
numerically and textually.

The basic layout of the programme and action of some of the tools is similar to that of
Microsoft Word. See Fig 2

The Document is called a Book and is split into three separate sheets, accessed by tabs at
the bottom left corner of the page. Each sheet is split into cells and each cell has a specific
address, a textual reference at the top of the page and a numeric reference at the left-hand
side of the page.

On opening, the programme defaults to having a black border around the top left-hand cor-
ner. This denotes that this is the active cell and is confirmed by the fact that the text field
marked (1) has the cell address A1 in it.

The cursor in Excel alternates between being a very fat white cross in the main cell area, a
white arrow in the Tool and Menu bar area and an insertion point in any text fields.

Manipulating & Selecting Cells
1. In order to increase the width of a cell you must place the cursor in the alphabetic
reference bar on the dividing line between to cells. The cross will change to a thick
vertical line split by a horizontal line with arrows at either end. Holding down the left
mouse button and dragging to the left or right will resize the width of the column.
2. To resize the height of a row repeat the steps in the previous section but this time
in the number reference bar.
3. To select a cell, place the cross on the designated cell and click once. To select
multiple cells, click in one cell, hold down the mouse key and drag horizontally to take
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Fig 1

(1)

(2)

Fig 2



in a row, vertically to take in a column and diagonally to capture cells in both a hori-
zontal and vertical plain. Note: Each cell will change from white to black with the
exception of the one you started with, it is selected none the less.

Entering Information in a Cell
1. To enter any information simply click the cross on the cell you wish, this will select
the cell. With the cell selected, start to type the information, which will appear not only
in the selected cell but also in the Formula bar indicated in Figure1 marked (2). 
2. To change the information you can select the text in the normal way in the Formula
bar or double click on the cell you wish to change, which will result in the black border
changing to a lighter weight and the insertion bar flashing in the cell. Selection can
then be carried out on the contents and appropriate changes made. 
3. To confirm the entries click the green tick in the Formula bar. 

Navigating Cells
1. There are several ways to move from cell to cell. You have learnt one already, that
is, by simply placing the cursor in a cell and clicking once.
2. After entering information into a cell you can move to the right by using the Tab key,
holding down the shift key and Tabbing once more will cause the selection to jump to
the left.
3. Enter your information and this time use the Enter Key; this will cause the selection
to move immediately below the last entry. Using Shift will modify this to cause the
selection to move upwards.
4. The last way is to use the cursor Arrows on the keyboard to navigate in the respec-
tive direction indicated by the Arrow key. 
5. Each of the above methods will confirm the entry in the cell you are moving from.

Moving Information in a Cell
1. If you want to move information from one cell to another, select the cell and pro-
ceed to the Cut icon in the toolbar this will copy your selection to the clipboard and
create a “marching ant” border around the text. Proceed to the new cell you want and
select it. Now go to Paste and this will copy what you cut from the previous cell to the
new destination and delete the contents from the original cell.
2. Another method is to select the cell and as you leave the cell the cursor changes to
a white arrow; pause at this point and holding down the left mouse button drag the
selected cell to a new destination.
3. You will of course have to take care using either of these methods that the size of
the cell you are moving is large enough to take the information being moved in to it,
although this will not stop you from transferring the information. You can of course
resize the cell after the move.

Toolbars

a) This tool is called AutoSum( Sigma in Greek). It will let you add up columns or
rows of numbers and input the answer in a cell previously selected by you. It works as
follows:
Enter 5 figures in a row across the page, click in the cell to the right of the last figure
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you entered and go to        AutoSum and click once. This should result in a similar lay-
out as that shown in Fig 3. Clicking the green arrow will enter the sum of the
figures contained in the
marching ants. 
If you had wished to, you
could have placed the
answer anywhere on the
sheet and after clicking
AutoSum select the cells
you wished to sum. This method can be used for adding columns in exactly the same
manner.

b) This is the Paste Function tool. When you need to analyse whether values in a list
(a series of worksheet rows that contain related data, such as an invoice data-
base or a set of client names and
phone numbers. A list can be used
as a database, in which rows are
records and columns are fields)
meet a specific condition, or criteria,
you can use a database worksheet
function. The following example
deals with numbers:
Type in a row in the spreadsheet the
following five numbers, 56, 34, 23,
89 and 234, then to the right of 234
select the adjacent cell. Proceed to
the Paste Function tool and left
click. You will be given a floating
window identical to the one    shown
in Figure 4. The Function category is shown to the left and the name of the function
shown to the right. Select "All" in the Category list and "Average" in the Function list,
then press "Ok". 

Clicking "OK " will return
the average of the numbers
and place the result in the
selected cell, in this case
the answer is 87.2, (see
Fig 5). Various functions
can be found by the same
means.

c) These icons will sort selected information in ascending or descending order
whether the information is alphabetical or numeric.
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Fig 3

Fig 4

Fig 5

(f) (g)(e)(d)



d) The Currency Tool. To use this tool select a column or row of figures and then left
click the Currency tool, this will prefix each figure with a "£" sign. Alternatively, select a
row or column of empty cells and apply the Currency tool, thereafter when you type a
number in this cell the number will be prefixed with a  "£".  Should you wish to apply a
Dollar sign this can be changed within the settings of the programme.
e) This will apply a Percentage style to the figure you have entered.
f) Comma Style will insert a comma in the appropriate position of a sizeable number.
g) These two icons will increase the decimal point and decrease the decimal point
respectively.
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Evaluation Basic
1. Set your entire document  in "Page set up" to: Top and Bottom 1" (2.5cm) and Right and
left 1.25" (3.125cm). Return to the document and set the Columns icon to 2 columns.

2. Type out the heading and Format the text accordingly.

3. Type out the first paragraph. Set the font to Arial 12. Bold the "T" and increase the font
weight by 1 in "The" at the start of the paragraph. Underline "exercise" and finally Justify the
paragraph.

4. Type out the next paragraph in the same font. Italicise the text and align the whole para-
graph to the right.

5. Set the next short paragraph with Garamond as it's font is at the same weight, and centre
the paragraph.

6. For the small Table you will need to choose the "Insert Microsoft Excel Worksheet". From
the drop down chart choose 3 columns by 4 rows. The headings are bolded, underlined and
centered. The additions were arrived at using the Sum tool.

7. This Paragraph is set in Arial pt size 12, Bolded and the colour set to red.

8. The next small paragraph has been set in the same font as above with no style and the
word "paragraph" has been highlighted in yellow.

9. This paragraph tells you exactly what it wants.

10. You will need to navigate to "Clipart" to find an image; it does not need to be this particular
one. The Route to "Clipart" is: Insert Picture Clipart.

11. The aim here is to set out the short paragraph as an address. To do this you must re set
your "Tabs"

12. To create the stick of rock. You must first create an oval shape. Leaving it selected pro-
ceed to the "Text box " tool and click it once then return to the oval shape and click once
inside it. You should now have in insertion point flashing in the oval . You can now type the
words "Retreat  Rock". You may have to resize your text and possibly the oval shape. Make
sure the oval is selected and now proceed to the "3D" tool.  Again you may have to resize the
shape on your layout.

13. This paragraph is written into a Text box and a line border set.

14. This was created as "Word Art". Proceed to the "Word Art" icon, click once and choose the
style in the top left hand corner. Clicking once will bring up the "Text editor" showing the words
"Type Your Text Here". Leave the font and point size at their default settings and type in the
date. Click "Ok" and the text along with a small floating window will appear on your document.
Leaving the text selected go to the "Drop shadow" tool and choose shadow style 14, now
choose from the small window, the "Free Rotate" tool and turn the object to roughly the angle
being shown. If you want to change the colour of your text, do so if you wish.

15. Finally copy the paragraph you dealt with in section 7 and paste it in to the end of your
document.
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EXERCISE NO 1

3. 
The following little exercise will hopefully
let you try out some of the aspects of this
software application that you have been
taught over the past few weeks.

4.
The first paragraph you typed was set as

justified type, this, the second will be
saved as right aligned.

5.
This one short as it is centre aligned if you set it
correctly.

6.

7.
You should be able to change the
colour of the text.  Change this para-
graph to red coloured bold text

8.
Highlight part of this paragraph with yellow
highlighter.

9.

This paragraph must
be set at a point size of
20 and the font set to
Bookman Old style.

This is a short
Paragraph
Styled 
Like an
Address.

13

14.

15.
You should be able to change the colour of
the text.  Change this paragraph to red
coloured bold text
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Date Oranges Apples
01/03/2000 45 23
01/03/2000 34 45

79 68

10.

 

Rock

11

12

See if you can create this little graphic
instance and write in the box giving the
box a nice border.

 


